
LView 1.5 

 LView 1.5, copyright 1993 Leonardo Haddad Loureiro, all rights reserved. 
 This software may be freely used and distributed, as long as the package is kept as a whole 
and no alterations are made, or any editing or reverse engineering is performed on any of 
the files contained in the package. 
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File Menu 

 In the File Menu you will find commands to open/save an image file, possibly converting its 
format. 

 Open 
 Save 
 Save as 
 Delete 
 Exit 



File/Open command 

 This command will open a dialog window to specify the file name and directory for the 
image to be loaded. Loading attributes comply with the current setup. See the Options Menu
for information. 



File/Save command 

 This command saves the displayed image using the original file name.    Attributes comply
with the current setup. See the Options Menu for information. 



File/Save as command 

 This command will open a dialog window to specify the new file name to which the image 
is to be saved. Image saving attributes comply with to the current setup. See the Options 
Menu for information. 



File/Delete command 

 This command will delete the last filename successfully opened or saved. You will be 
prompted for a confirmation, before deletion takes place. 



File/Exit command 

 This command will end LView 1.5. If an image is being loaded or saved when you select this 
command, LView will prompt you for a confirmation before exiting. 



Edit Menu 

 In the Edit Menu you will find commands to access the clipboard, and change image size, 
position and other attributes. 
 Clipboard commands: 

 Cut 
 Copy 
 Paste 
 Delete 

 Size & Position commands 
 Crop 
 Resize 
 Flip Horizontal 
 Flip Vertical 
 Rotate ClockWise 
 Rot CounterClkWise 

 Image attribute commands. 
 HSV Adjustment 
 Color Balance 
 Contrast Enhancement 
 Gamma Correction 



Edit/Cut command 

 Transfers the current image to the clipboard, and erases it from LView's window. This 
command is useful when Windows is low in memory. If you want to copy the image to the 
clipboard and retain it in LView, use the Copy command. 

 If you select this option after defining a rectangular area on the image, LView will copy 
only the selected rectangular area to the clipboard. 



Edit/Copy command 

 Copies the current image to the clipboard. This command does not erase the image from 
LView's window. If Windows is low in memory, try the Cut command. 

 If you select this option after defining a rectangular area on the image, LView will copy 
only the selected rectangular area to the clipboard. 



Edit/Paste command 

 Copies an image from the clipboard to LView's window. 



Edit/Delete command 

 Deletes the image from LView's window. This is useful to free memory without exiting 
LView. 



Edit/Crop command 

 Crops the image to the defined rectangle. Only the region inside the rectangle is kept. 
 To define a rectangle, click the left mouse button, and drag the mouse without releasing 

it. When you are done, release the button. While defining the rectangle, its dimensions will 
appear in the window's caption bar. If the image is larger than the window, moving the 
mouse outside the window will make it scroll. Clicking the right mouse button while scrolling 
(without releasing the left button) will provoke a "fast scroll" to the end of the image. 

 Cropping images is specially useful before converting GIF files to JPEG format. Always crop
the border around the image, to improve both compression quality and ratio. 



Edit/Flip Horizontal command 

 Flips (mirrors) the image horizontally. 



Edit/Flip Vertical command 

 Flips (mirrors) the image vertically. 



Edit/Rotate ClockWise command 

 Rotates the image clockwise, transforming rows into columns and vice-versa. 



Edit/Rot CounterClkWise 
command 

 Rotates the image counter clockwise, transforming rows into columns and vice-versa. 



Edit/Resize dialog 

 Resizes the image to a new width and height. 
 You will set the new width and height in a dialog, where you can choose from a few 

predefined dimensions or define custom values for width and height. The "Fit to desktop" 
option will resize the image to the maximum dimensions the current graphics mode can 
exhibit without using scrollbars. 

 In the Resize dialog, keeping the "Preserve aspect ratio" box checked will make LView 
recalculate the specified    width or height to preserve the image aspect ratio. The image's 
new width and height will not exceed the ones you choose. This will work for the predefined 
dimensions as well. 



Edit/HSV Adjustment command 

 This command will open a dialog window with scrollbars to edit HSV values for the image 
displayed. Moving the scrollbars will change each attribute. Lower/Upper values will 
Decrease/Increase the global amount of (H)ue, (S)aturation and (V)alue for the image. 

 During a display/edit session of an 8-bit image, moving the scollbars will automatically 
alter the image. For 24-bit images, you will have to set a new value for each component, and
then click on the "EXEC" button for the changes to effect. As HSV editing is slower (but still 
feasible) for 24-bit images, making all the desired changes in one pass will cut down editing 
time. 

 All changes are performed on the original image. If you are satisfied with an HSV setting, 
click on the "UPDT" button, and the original image are updated to the current editing setting.
If after further editing you click on the "CANCEL" button, you will exit the dialog, and the 
image will be reset to the last update saved. Click on "OK" to update the image to the 
current setting and exit the dialog. 

 Prop Sat and Prop Val: 
 These are two check boxes in the HSV dialog. When checked, they will make LView alter 

Saturation and Value attributes "proportionally". In short, this means that when you increase
Saturation or Value attributes for the image, pixels low on the edited attribute will be more 
increased than pixels high on it. Converselly, when you decrease the attribute value for the 
image, pixels hight on the attribute will be more decreased than pictures low on it. If you 
uncheck these boxes, Saturation/Value offsets apply equally to all pixels. Checking is useful, 
for instance, to brighten up the darker pixels of an image without making it's brighter pixels 
too bright. Note that extremely dark pixels may not brighten up consistently. 



Edit/Contrast Enhancement 
command 

 This command will open a dialog for the image. Increasing/Decreasing the Contrast value 
will increase/decrease the image's Contrast. 

 NOTE: I am still looking for a better algorithm for Contrast editing. suggestions are 
welcome! 



Edit/Color Balance command 

 This command will open a dialog window to edit the Red, Green and Blue attributes of the 
image. Increasing/Decreasing any of these attributes will increase/decrease the 
corresponding value for each pixel on the image. If you are viewing a 24-bit image, set new 
offset values for Red, Green and Blue and then press the "Exec" button to execute your 
choices. On a 256 color display, editions will be executed as soon as defined. 



Edit/Gamma Correction 

 This command will open a dialog window to edit the gamma (brightness) value for the 
Red, Green and Blue attributes of the image. Increasing/Decreasing any of these attributes 
will increase/decrease the corresponding gamma value for each pixel on the image. 
Selecting "Lock RGB" will make LView apply the same gamma to Red, Green and Blue 
components. Unchecking "Lock RGB" will allow for individual gamma settings for Red, Green 
and Blue. If you are viewing a 24-bit image, and "Lock RGB" is not selected, set new gamma 
values for Red, Green and Blue and then press the "Exec" button to execute your choices. 
On a 256 color display, or if "Lock RGB" is unchecked, editions will executed as soon as 
defined. 



Options Menu 

 In the Options Menu you will find commands to configure several aspects of LView's 
behavior. Your execution options can be saved, restored or reset default values. 

 8-bit Bitmap 
 Write 1&4 bit Bitmaps 
 Auto-resize 
 Drop to 
 JPEG Options 
 Slideshow Options 
 Load all Options 
 Save all Options 
 Defaut Options 



Options/8-bit Bitmap command 

 Regardless of their file format, images are translated into Windows Device Independent 
(DIB) format when loaded. LView can work with 8 and 24 DIBs. Set this option to make LView 
use an 8 bit DIB even when loading a 24 bit image. If your video card is limited to 256 colors,
you can still view 24 bit images using 8 bit Bitmaps. When reading JPEG files (stored with 24-
bit per pixel color information), LView will quantize the image according to the options you 
set in the JPEG Options dialog. 

 This option will be automatically selected if LView senses that your display can handle at 
most 8-bit pixel resolution (with palette references). If you then uncheck this option, LView 
will warn you that images will not be displayed correctly. Nevertheless, you should uncheck 
this option to perform format conversions, or image editions. This way, even if the image 
you see on the screen seems to have the "wrong" colors, image quality loss will be reduced 
in the process of saving edited/converted images. 



Options/Auto-resize command 

 Turning this option on will make LView try to resize it's window to the size of the image 
being displayed. If the image doesn't fit the maximum window size of your desktop, 
scrollbars will be added to LView's window. Turning this option off will prevent LView from 
changing its window size. 



Options/Drop to command 

 LView can automatically load a group of files, either to show them as a slideshow, or to 
compress them in batch to JPEG format. Use Window's File Manager to select the files you 
wish to view or compress, and then drag them to LView's window. If you set this option to 
"Slideshow", LView will load the files and show them successively. If you set this option to 
"Compress", the files will be compressed using the current JPEG Options . To interrupt batch 
compression, or slideshow viewing, click the right mouse button anywhere in LView's client 
area, or just select the Menu Bar option. 



Options/Slideshow Options 
dialog 

 In this dialog you can customize LView's Slideshow behavior. Pictures can be switched 
"automatic"ally (timed), or "manual"ly. 

 If you choose "automatic", LView will start to load the next Slide after the specified delay 
time. 

 If you choose "manual", LView will wait until you click the left mouse button anywhere 
inside LView's client area to begin loading the next Slide 

 If you check the "Cycle Slideshow" checkbox, LView will reload the first Slide after you 
view the last one, and restart the slideshow. 

 To interrupt the slideshow, click the right mouse button anywhere inside LView's client 
area. You will be prompted to confirm that you want to stop the slideshow. 



Options/Load all Options 
command 

 Clicking on this menu item will make LView reload all options from disk. Use this command
if you set options for a particular image, and want to reset your configuration without having
to reset each altered option individually. 



Options/Save all Options 
command 

 Most of the options set by menus and/or dialogs can be altered and the new setup can be 
saved. Use this menu item to save your customized LView setup. 



Options/Default Options 
command 

 This menu item will restore LView's "factory defaults". 



Options/Write 1&4 bit Bitmaps 
command 

 LView can process images of less than 16 colors. If you turn this option on, When you save
a file to either Windows Bitmap or OS/2 Bitmap format, LView will, whenever possible, create
1 or 4 bit Bitmap files. If you turn this option off, only 8 or 24 bit Bitmap files will be written. 



Options/JPEG Options dialog 

 In this dialog you will customize JPEG decompression (for loading images) and 
compression (for saving images and batch compression) parameters. 

 Decompression setup 
 If you enable the 8-bit Bitmap menu item, JPEG images will be quantized for display. You 

should not enable this option for batch compressions. You can set the number of quantizing 
passes to one or two. You can also turn Floyd-Steinberg dithering on/off for quantized 
images. For quantized images, the total number of colors in the generated palette is set with
NColors. The best results, of course, will be obtained with 256 colors, but you can 
experiment with fewer colors. Furthermore, if you set NColors to 16 or less, and also set both
8-bit Bitmaps and Write 1&4 bit Bitmaps , saving the image to Windows or OS/2 DIB formats 
will produce DIBs with fewer bits per pixel, which, besides taking less disk space, can be 
used as icons. Checking the "Load GrayScale" checkbox will force JPEG images to be loaded 
without color information (only intensity). 

 "Load GrayScale" mode provides faster loading of image files, and can be usefull for 
image previewing. 

 Compression setup 
 JPEG compression is "lossy". This means that the image you compress will not exactly 

match the original image. The "Quality" setting allows you to compromise between file size 
and compression fidelity. Set larger/smaller values for "Quality" to get larger/smaller files, 
with better/worse fidelity compared to the original image. In LView, the minimum value 
allowed for "Quality" is 20, and the maximum 95. When compressing images that have been
dithered, increasing the value for "Smooth Factor" will make LView try to reduce image 
noise. That way you will get a smaller and (generally) better image. "Smooth Factor" may 
vary from 0 to 100, and usually a value of 20 to 50 will work fine for dithered images. Keep 
"Smooth Factor" turned off (zeroed) when saving non-dithered images. When checked, the 
"Entropy Optimization" option will make LView optimize JPEG compression tables, and 
generate smaller files. It will also marginally slowdown compression. When checked, the 
"Save GrayScale" option will compress the image in grayscale, regardless of its original color
information. Turn this option on to save a grayscale image. DON'T FORGET TO TURN IT OFF 
AFTERWARDS. Sampling factors may be set to h2v2 (the default) or h2v1. Use h2v2 to 
obtain better compression ratios. h2v1 usually produces better image compression quality, 
at the expense of generating larger files. 

 The "Default Setup" button will restore the "factory defaults" for JPEG Options alone. 



Image file formats 

 In this version (1.5) LView can load and save images in: 
 JPEG JFIF format: 24 bit image format. 
 GIF 87a/89a: up to 8 bit image format. 
 Truevision TARGA: up to 24 bit image format. 
 Windows or OS/2 DIB format: 1, 4, 8, or 24 bit image format. 
 Notes: 
 RLE compressed DIBs are not supported. 
 In future versions of this product, new file formats may be supported. Also, faster 

algorithms for loading/saving currently supported formats may be developed. 



More about LView 1.5 ... 

 I was amazed the first time I saw a JPEG compressed image file. Shortly after that, I 
decided to do some programming and research on the subject. Well, LView 1.0 was the result
of that effort. LView 1.5 is a result of the feedback I received from LView 1.0 users. 

 This viewer was primarily made for my own usage and enjoyment. A goal that was fully 
achieved. As many people have directly and indirectly contributed to the making of this 
software, including the Jpeg Independent Group with its excelent work, I decided to make it 
available to whoever wants to use it. 

 I have some ideas for the next versions of LView, and I'd also like to read from you, LView 
users. Not only bug reports, but also comments and suggestions are welcome. 

 My name is Leonardo Loureiro, and I can be reached at: mmedia@world.std.com, please 
mention LView in the subject line of all email messages you send. 

 Enjoy ! 



Disclaimer 

 Licensing Agreement 
 You are granted the right to use and to make an unlimited number of copies of this 
software. You may not disassemble, decompose, reverse engineer, or alter this file or any of 
the other files in the package. This includes, but is not limited to modifying any icons, 
menus, or displays associated with the software. 
 This software is provided as FREEWARE and cannot be sold. This restriction does not apply 
to connect time charges, or flat rate connection/download fees for electronic bulletin board 
services. This software can not be bundled with any commercial package without express 
written permission from the author. 
 The author of this program accepts no responsibility for damages resulting from the use of 
this product and makes no warranty or representation, either express or implied, including 
but not limited to, any implied warranty of merchantability or fitness for a particular 
purpose.    This software is provided as is, and you, its user, assume all risks when using it. 
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